
CCDOPS Version 3 New Features 

This Application Note describes the new features that were added to CCDOPS Version 3. Essentially CCDOPS Version 1.0 
for the ST-4X/5/6 was merged with CCDOPS Version 2.0 for the ST-7/8 and some further enhancements and bug fixes were 
made to create CCDOPS Version 3.0. The Sections below discuss the additions made to the software on a topic by topic basis.

File Handling Routines

 The following enhancements have been made to the way CCDOPS handles images both on the disk and in memory:
	 •	� The software now detects Extended memory and uses it for image buffers. This gets around the DOS 640K memory limit. 

You can see how much memory the software detected in the About dialog when the program first starts up or by using the 
About CCDOPS command in the “*” menu. On PCs that have extended memory you will need to make sure the HIMEM.
SYS driver is included in your CONFIG.SYS file. HIMEM.SYS is a memory manager for the Extended memory (memory 
above 1 Megabyte) that CCDOPS uses for allocating the image buffers.

	 •	� The File Open dialog now allows you to navigate the drive/directory structure by showing the directories and drives as well 
as the files. You can now double-click on a different drive or directory to change the current working directory. We also 
added the popular “rebound” feature where the software remembers the last file that was selected and repositions the File 
Open dialog at that position the next time. This makes averaging a series of images a snap.

	 •	� The Auto Grab feature of the Grab and Focus commands allow you to have the 3 digit numerical index (001, 002, etc.) 
reside in the extension or at the end of the filename. If you don’t explicitly specify an extension in the name the index is 
appended as the extension (e.g. AUTO.001, AUTO.002, etc.). If you do specify an extension the index is placed at the end 
of the file name (e.g. AUTO001.ST6, AUTO002.ST6, etc.).

	 •	� You can now access the File Path dialog, where you can graphically select the current path, from the Path/Filter dialog or 
the various File Save dialogs by clicking on the Path button or hitting the Home key.

	 •	� The FITS header has been extended to include more of the image information contained in the SBIG header.
	 •	� When you save an image with the Save command in the File menu CCDOPS will now automatically append a camera type 

extension to files names if you don’t explicitly specify an extension. For example if you save an ST-6 image and enter the 
name M27 the image will be saved as M27.ST6.

	 •	� The Create Directory command in the File menu now makes the new directory become the current one without you 
having to say so.

Acquisition Routines

The following enhancements have been made to the way CCDOPS acquires images through the Grab, Focus and Track and 
Accumulate functions:
	 •	� We extended the Auto Grab feature to the Focus command which makes taking planetary images a snap. If you set the 

Auto Grab item of the Focus dialog to yes the software brings up the Auto Grab dialog where you can set the name for the 
sequence (see the notes about the Auto Grab file names under the File Handling Routines section), the number of images 
to acquire and the interval between images. Once in Auto Grab mode the software logs the images to disk automatically 
unless you select the Manual Update mode. In the Manual Update mode the software pauses after each image to allow you 
to review it. You can then hit the Space bar to skip the image or the “G” key (for Grab) to keep the image and log it to 
disk.

	 •	� You can now change the image contrast from within the Focus command. Using the Contrast pull-down menu item or 
hitting the “C” key allows you to switch between Auto and Manual contrast modes, and in Manual mode, adjust the Back 
and Range parameters.

	 •	� The Track and Accumulate software now graphs the Total Error (instead of the Residual Error) and shows the Total, 
Residual, and Average Residual Error in the table of tracking results. The Total Error is how far the star has drifted from its 
original position and the Residual Error is the sub-pixel error remaining after the image is shifted in whole-pixel amounts 
to correct for the Total Error.



	 •	� A delay parameter has been added to the Focus dialog which when set to a non-zero value causes a delay after the image 
has been displayed to allow you time to adjust the telescope’s focus and let the telescope settle before the next image is 
started.

	 •	� We’ve added a Default Note command to the Misc menu that allows you to enter some information that will get placed 
into the note or comment field of newly acquired images. The data you enter, if it’s not blank, overrides the default note 
which contained the date and time the image was taken (which are redundant with other items in the image header).

	 •	� The Auto Grab function of the Grab command is now able to reuse dark frames.
	 •	 We’ve made the Quarter Frame images one pixel larger so they could be Zoomed.

Display Routines

The following enhancements have been made to the way CCDOPS displays images:
	 •	� The software now supports the VESA compliant Super VGA 256 color graphics modes for the following display/acquisition 

modes:
			   • �Display Command/Analysis Mode - The software uses the 640x480 mode for displaying the image if you have selected 

VESA for the Graphics card in the Graphics Setup command in the Misc menu.
	 		  • �Display Command/Photo Mode - If you select Auto or VESA for the Graphics card in the Graphics Setup command of 

the Misc menu the software will use the 640x400, 640x480, 800x600 or 1024x768 display modes to show the whole 
image or as much of the image as possible.

		  	 • �Other Commands - The software uses the 640x480 mode for displaying the image if you have selected VESA for the 
Graphics card in the Graphics Setup command in the Misc menu

	 •	� A further advantage of the VESA display modes when used with the Display command is that you can adjust the image’s 
brightness and contrast in real time. The Up/Down arrow keys adjust the image brightness and the Left/Right arrow keys 
adjust the contrast.

	 •	� The Crosshairs functions have been extended to include a measurement of the RMS pixel variation and the Seeing. 
Furthermore, the crosshair can now be enlarged to 31x31 pixels. The Noise is the RMS variation of all the pixels in the 
crosshairs box and is reported in counts or ADUs. To convert to electrons you need to multiply by the gain of the image 
which can be seen in the Image Parameters command in the Display menu. The Seeing is a measurement based upon the 
data under the cursor of the star’s full-width at half maximum and is reported in arcseconds. You need to make sure you’ve 
specified the telescope’s focal length in the Telescope Setup command to allow the CCDOPS software to determine the 
proper calibration factor between pixels and arcseconds.

	 •	� In the Astrometric measurements of the Crosshairs command we changed the way angles are reported to be the angle CW 
from Up. For comparison to standard Astrometric measurements of binary stars this assumes you have oriented the CCD 
image (using the horizontal and vertical flip commands) such the North is up and East is to the right.

Image Processing Routines

The following enhancements have been made to the Image Processing commands:
	 •	� We added the Print command to the File menu that allows you to print images on HP and Postscript printers. For most 

astronomical images printing the images as a negative produces the best results. You can also “print” the image to disk for 
printing on other PCs.

	 •	� The Enlarge and Reduce Image 2X commands have been added to the Utility menu. These command take the entire image 
(unlike the Zoom command which uses a portion of the image) and enlarge or reduce the number of pixels 2x2 through 
pixel interpolation or reduction.

	 •	� We’ve added an adaptive dark subtract routine to adjust dark frames for small temperature changes from night to night. 
When you use the Dark Subtract command in the Utility menu the software now gives you a choice of using the Standard 
dark subtraction (the old method) or using an Adaptive method that compares the light and dark images and makes minor 
changes to the dark frame to minimize the effects of hot pixels. While we still feel the best results are always obtained by 
taking dark frames in close proximity to the light frames, using the Adaptive routine can improve the results obtained by 
users that use libraries of dark frames.

	 •	� The Remove Hot Pixels command now has a fourth option to remove Saturated pixels. This removes isolated saturated 
pixels from the image by replacing the saturated pixel with the average of its unsaturated neighbors.

	 •	� The Column Repair command has been added to the Utility menu which allows you to repair column or 
row defects. It replaces the affected column/row with the average of its two neighbors.



Tracking Routines

The following enhancements have been made to the Tracking and Self Guiding capabilities:
	 •	� The Self Guide command has been added to the Track menu for ST-7/ST-8 users. This allows users of those cameras to 

use the ST-7/ST-8’s 2nd CCD to Self Guide images.
	 •	� As a diagnostic tool we added the ability to log tracking images to disk while the cameras are tracking. If you set the Log 

tracking item in the Tracking Parameters menu to yes the Track and Self Guide commands record all the tracking images to 
disk in a Track Log file. You can then use the Convert Track Log File command in the Track menu to make an image that 
is a mosaic of the tracking images. This command also asks for the name of a report file where it creates a “spreadsheet” 
of the tracking performance, showing the tracking error in both X and Y over time. The images and report can help you 
solve mechanical problems with your system that degrade the ultimate tracking performance.

	 •	� We’ve improved the sensitivity and fastest repetition rate for self-guided ST-7/ST-8 images. * With the ST-7/8 you can now 
calibrate for tracking using the Imaging CCD and the measured calibration parameters will be adjusted for the Tracking 
CCD.

	 •	� We’ve added X and Y backlash parameters to the Tracking Parameters dialog that allow the CCDOPS software to compensate 
for drive train backlash in your telescope. While there is no substitute for a good, no-backlash drive system, setting these 
parameters to the amount of backlash present in your system (in seconds) can improve the tracking performance. Setting 
these parameters to zero cancels any backlash compensation, and should be tried initially. Setting these values too high can 
degrade the tracking performance severely as the drive becomes unstable and overshoots.

	 •	� We added an Aggressiveness item to the Tracking Parameters dialog which scales from 1 to 10 and allows reducing 
the corrections the camera applies to the telescope to “mellow” out the tracking. You would set this parameter to 5 if 
somehow you thought the camera were too active (compared to hand guiding) and you wanted to reduce the corrections 
to 50% * We added the guide star’s brightness to the track and self guide displays so you can see if the atmospheric 
conditions are degrading. Additionally the software now allows the guide star’s brightness to drop to 20% for 4 consecutive 
images before it will abort the tracking.

	 •	� We added the ability to reverse the X corrections in Track and Self Guide modes for users with German Equatorial 
mounts. This allows you to swing to the other side of the fork without having to recalibrate. The X direction parameter 
in the Tracking Parameters dialog allows you to reverse the X corrections. This only works if you have aligned the camera 
such that the X direction is aligned with RA.

	 •	� Self guided images that are terminated early due to seeing or tracking conditions are now retained so you can decide 
whether to keep them or discard them.

	 •	� You can now access the Tracking Parameters dialog from the Track and Self Guide dialogs by clicking on the Param button 
or hitting the Home key.

	 •	� The size of the displayed track box when you select the guide star is now corrected for any reduction or enlargement 
necessary to display the full frame image.

Communications Routines

The following enhancements have been made to the communications routines in CCDOPS:
	 •	� We added a Camera Info command to the Camera menu that interrogates the attached camera and reports the firmware 

version, readout modes supported, etc.
	 •	� The serial routines now allow you to configure the ports and interrupts. COM 1 thru COM 4 now have entries in the 

CCDOPS.CFG file that you can edit with Edit or your favorite text editor. These entries allow you to set the base address 
(see the Com_address line) and interrupt (see the Com_irq line) used for each of these ports. Note that the software will 
not let you share the same interrupt between the Mouse and the COM port. If you try to do this the software will not 
allow you to select the COM port that shares the interrupt with the Mouse. Also note that the default settings of these 
parameters in the CCDOPS.CFG file uses the standard PC address and interrupt lines for the four COM ports.

	 •	� We’ve added the additional 38.4K baud rate for users that couldn’t maintain 57.6K but could maintain speeds in excess of 
19.2K baud.

	 •	� You can now access the Camera Setup dialog from the Grab and Focus dialogs by clicking on the Setup button or hitting 
the Home key.

	 •	� The serial communications routines now support the FIFO of the 16550 based serial ports which extends 
the higher speed 115.2K baud to slower computers.
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Accessory Items

The following enhancements have been made to CCDOPS when using accessory items such as the Color Filter Wheel:
	 •	� The Filter Menu has been added to the end of the menu bar for use with SBIG Color Filter Wheels. The Filter Setup 

command allows you to name the filters and tell the software what type of filter wheel is being used. The Calibrate command 
allows users of the CFW-6A to calibrate the filter positions. Finally, the six positioning commands allow positioning the 
motorized filter wheels or telling the software which manually positioned filter is in place.

	 •	� ST-4X and ST-5 users with motorized filter wheels can now use the filter wheel as a shutter for taking dark frames. To do 
this you need to cover up one of the unused positions in the carousel with some opaque material ( a sandwich of aluminum 
foil between construction paper works well) then set the Dark position item of the Filter Setup command to the dark 
position. Then rather than asking you to cover or uncover the telescope, the software will merely position the filter wheel 
to the dark position for the dark frame then return the filter wheel to its original position for the light frames.

	 •	� We’ve added the CFW-8 to the choice of filter wheels in Filter Setup command. Please note that even though the CFW-8 
only has five filter positions the CCDOPS software won’t warn you if you try to select the 6th position. The CFW-8 will 
just stay put.

Miscellaneous

The following items pertain to miscellaneous features of CCDOPS that have been enhanced:
	 •	� The PC Setup command in the Misc menu has been split in two. The Graphics Setup command contains the PC related 

setup items such as the Graphics adapter, mouse, etc. The Communications Setup command contains the Serial and Printer 
port items.

	 •	� The keyboard ESC is now recognized even if a different key was hit first by mistake.
	 •	� The pixel sizes, in arcseconds, have been added to the Image Parameters command of the Display menu. For these values 

to reflect the actual pixel subtense the Telescope’s focal length must be accurately set.
	 •	� Many dialogs now have a third button in the left of the dialog that is a hot-link to a related dialog. This button is in addition 

to the Enter or Esc buttons and can be activated by clicking on it with the mouse or by hitting the Home key on the keypad.
	 •	� The average pixel value and RMS pixel variation parameters have been added to the bottom of the textual histogram display.
	 •	� The software will now run on an 80286.

Bug Fixes

The following software bugs have been corrected in CCDOPS. Please help us to continue to improve CCDOPS by reporting 
bugs to us.
	 •	 Fixed a bug in the Replicate command where the bottom line of the image would get corrupted.
	 •	 Fixed a bug with the CFW-6A where on rare occasion the filter wheel would not move.
	 •	� Fixed a bug where loading images that were too wide (from 3rd party software packages) could cause the program to 

bomb.
	 •	 Fixed a bug in the Auto Scale Histogram to not show points beyond 65K.
	 •	 Removed an earlier DOS work-around that was causing the date to advance too frequently.
	 •	 Fixed a bug where the Top item in the Display dialog was getting ignored in some display modes.
	 •	 Fixed a bug where images wider than 640 pixels would not smooth correctly in photo display mode.
	 •	 Fixed a bug in the Combine by Track List command where the final image would be corrupted.
	 •	� Fixed a bug for ST-7/ST-8 users where the Background and Range would be adjusted as the camera switched resolution 

modes in the Auto res focus mode.


